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Введение

Eureka - редактор карт классического DOOM и основанных на его движке игр - Heretic и Hexen. Поддерживает работу в Linux, Windows и OS X.

Проект находится по адресу http://eureka-editor.sourceforge.net

Автор Eureka - Andrew Apted. Автор мануала и сборщик - Wesley Werner. Автор версии на русском языке - Arbars Zagadkin.


Мануал

Если вы заметили ошибку, прошу сообщить о ней здесь [https://github.com/wesleywerner/eureka-docs/issues].

По поводу ошибок в переводе, сообщайте о них сюда [https://github.com/Arbars/eureka-docs/issues].

Хочешь помочь с улучшением проекта? Сделай форк репозитория автора оригинала [https://github.com/wesleywerner/eureka-docs], или перевода [https://github.com/Arbars/eureka-docs] и отправь pull request.

Также есть PDF-версия данного мануала [https://readthedocs.org/projects/eureka-docs/downloads/].




Лицензия

Данный мануал распространяется под лицензией Creative Commons Attribution-ShareAlike 4.0 International License [http://creativecommons.org/licenses/by-sa/4.0/].







          

      

      

    

  

    
      
          
            
  
Установка


Системные требования

Файл IWAD, или «Internal (внутренний) WAD», содержит в себе карты, текстуры, звуки и прочие данные, которые идут по-умолчанию. Ты можешь использовать DOOM.WAD или DOOM2.WAD, если они у тебя есть.

В качестве альтернативы можно воспользоваться файлами проекта Freedoom [http://freedoom.github.io/] . Freedoom распространяется под свободной BSD лицензией и имеет в своём составе уровни, графику, звуки и музыку, и совместим с любым клаччическим Source-портом. Достаточно скачать и распаковать архив с файлами в любое удобное для тебя место. В случае с GNU / Linux можно положить файлы в каталог ~/.eureka/iwads/ или установить игру из репозиториев, и редактор автоматически их найдёт и подключит.


Движок Doom

Для того, чтобы тестировать карты, тебе понадобится движок Doom (source-порт). На выбор есть несколько вариантов:


	Chocolate Doom [https://www.chocolate-doom.org] - создан для сохранения опыта игры в оригинальном Doom на современных ОС. Неплохой вариант для тестов.


	PrBoom [http://prboom.sourceforge.net/] - продвинутый движок с кучей настроек совместимости. Стандарт для записи и просмотра демок.


	Crispy Doom [https://fabiangreffrath.github.io/crispy-doom] - минималистичное решение с парой плюшек.


	GZDoom [https://gzdoom.drdteam.org/] - продвинутый и модифицируемый движок с кучей особенностей, включая нестандартные. На первых порах привязывать карты к данному порту не рекомендуется.









Windows

Для скачивания последней версии редактора переходим на страницу проекта [https://sourceforge.net/projects/eureka-editor/] и жмём на большую кнопку «download». Распаковываем куда-нибудь архив и кликаем на eureka.exe.




GNU / Linux

По идее, Eureka уже есть в репозиотриях большинства популярных дистрибутивов. Но если нужна самая свежая версия, то придётся собирать из исходного кода.


	переходим на страницу загрузки проекта [https://sourceforge.net/projects/eureka-editor/files/Eureka/]


	скачиваем и распаковываем eureka-*-source.tar.gz


	ставим необходимые для сборки пакеты:




$ sudo apt-get install \
build-essential \
libfltk1.3-dev \
libxft-dev \
libxinerama-dev \
libfontconfig1-dev \
libjpeg-dev \
libpng12-dev \
zlib1g-dev \
xdg-utils






	собираем исполнимый файл




$ cd eureka*
$ make






	устанавливаем Eureka




$ sudo make install











          

      

      

    

  

    
      
          
            
  
Интерфейс пользователя

Eureka обладает двумя основными режимами работы с картой - 2D и 3D. Переключаться между режимами можно клавишей tab.

[image: ../_images/2d-view.png]
2D вид используется, собственно, для маппинга - построения уровней и расстановки предметов на них

[image: ../_images/3d-view.png]
3D вид используется для предпросмотра уровня при калибровке освещения, выборе текстур пола и потолка


Движение и масштабирование

Для перемещения в 2D виде используются:


	Колёсико мыши - масштабирование


	Средняя кнопка мыши (под колёсиком) - захват и перемещение рабочей поверхности


	Клавиша home - отмасштабировать рабочую область так, чтобы была видна вся карта целиком







Камера

Стрелочка в 2D виде показывает текущее положение 3D камеры.


	Клавиша ' (одиночная кавычка) в 2D виде переносит 3D камеру в точку, на которой находится курсор.


	Клавиша end в 2D виде определяет центром карты координаты 3D камеры.




[image: ../_images/camera.png]
В 3D управлять перемещением камеры можно следующими способами:


	Колёсико мыши - вперёд / назад


	Удерживать СКМ и двигать вправо / влево - поворот камеры


	Удерживать СКМ и двигать вперёд / назад - поднимать / опускать камеру







Сетка координат

Включать сетку координат можно в выпадающем меню Grid на нижней панели, или клавишей g. Быстро переключаться между размерами ячеек можно клавишами 0-9 в врехнем ряду клавиатуры.

Переключаться между режимами с привязкой к сетке и без можно клавишей f.

[image: ../_images/2d-grid.png]



Режимы отрисовки

В меню View / Sector Rendering можно выбрать режим отрисовки секторов.

[image: ../_images/sector-rendering-menu.png]

Полы

Сектора будут отрисовываться с текстурой пола.

[image: ../_images/sector-rendering-floors.png]



Потолки

Сектора будут отрисовываться с текстурой потолка.

[image: ../_images/sector-rendering-ceilings.png]



Освещённость

Данный режим показывает уровень освещённость секторов.

[image: ../_images/sector-rendering-lighting.png]



Звук

Этот режим показывает, как распространяется звук. Наводим курсор на нужный сектор, чтобы увидеть, как будет распространяться звук.

[image: ../_images/sector-rendering-sound.png]





Поиск и замена

Панель поиска и замены открывается через пункт меню View / Find или сочетанием клавиш control-f.

Можно искать предметы, текстуры линий, плоскости полов, линии по типу (спэшлу) или секторы по типу.

[image: ../_images/find-panel.png]






          

      

      

    

  

    
      
          
            
  
Работа с проектом

WAD-файл может содержать несколько карт, которые нумеруются согласно того порядка, который заложен в выбранном IWAD.

Для Doom1 или Freedoom: Pase 1 это 4 эпизода по 9 карт в каждом: E1M1-9, E2M1-9, E3M1-9 и E4M1-9.

Для Doom2 или Freedoom: Phase 2 это 32 карты: MAP01 - MAP32.

Данные мануал затачивается под Freedoom: Pase 1.


Создание нового WAD

Через пункт меню File -> New Project или сочетание клавиш Ctrl+N вызываем диалогое окно сохранения WAD, вбиваем имя файла, выбираем место, и кликаем «OK».

Затем, настраиваем новый проект:


	IWAD: выбираем freedoom1 из списка, жмём кнопку Find и указываем его местоположение.


	Source Port: выбираем boom (или тот, что нравится) из списка, жмём Setup и указываем местоположение екзешника


	В случае с GNU / Linux, расположение исполняемого файла можно узнать с помощью команды which prboom-plus.




Закансиваем настройку и кликаем OK.

[image: ../_images/new-project-dialog.png]



Открываем карту

Открываем окно выбора карты через пункт меню File -> Open Map или сочетание клавиш control-o. В выпадающем еню выбираем пункт Find map in the PWAD above, в противном случае для выбора будут доступны только карты из IWAD.

[image: ../_images/open-map.png]



Добавляем карту

Открываем окно добавления карты через пункт меню File -> Fresh Map. Розовым отмечены занятые слоты, зелёным - свободные.

[image: ../_images/fresh-map-dialog.png]



Переименовываем карту

Через пункт меню File -> Rename Map можно изменить порядок карт, выбрав в диалоговом окне новый слот.

Занятые слоты выбирать нельзя.

[image: ../_images/rename-map-dialog.png]



Копируем карту

Пункт меню File -> Copy Map открывает окно, в котором выбираем слот для скопированной карты.




Удаляем карту

Пункт меню File -> Delete Map удалит текущую карту из WAD, запросив подтвердение.




Экспортируем карту

Пункт меню File -> Export Map поможет экспортировать карту в:


	новый WAD


	уже существующий WAD




[image: ../_images/export-map-file-chooser.png]
Выбор файла, в который будет экспортирована карта

[image: ../_images/export-map-level-chooser.png]
Выбор слота, в который будет экспортирована карта







          

      

      

    

  

    
      
          
            
  
Базовые понятия


Вершины

Вершины соединяют линии сектора между собой.


	Жмём v в 2D виде для перехода в режим работы с вершинами


	ЛКМ на линии вставляет вершину


	ПКМ ставит вершину и включает режим рисования линий, в котором, продолжив жать ПКМ и замкнув контур, мы получим сектор




[image: ../_images/vertices.png]



Линии

Линии делят карту на сектора. Также они используются для укзания различных экшонов.

Жмём l в 2D виде, чтобы попасть в режим работы с линиями.

[image: ../_images/linedefs.png]
Также линия имеет лицевую и обратную стороны. Определить лицевую сторону линии можно по короткой перепендикулярной линии, выступающей из середины.

[image: ../_images/linedef-front.png]
линия повернута лицевой стороной вниз




Сектора

Сектор - участок карты, очерченный несколькими линиями.

Жмём s в 2D виде для перехода в режим работы с секторами.

[image: ../_images/sectors.png]



Объекты

Объект нужен для обозначения игрока, монстра, предметов дектораций, бонусов, точек старта в мультиплеере и точек телепорта.

Жмём t в 2D виде для перехода в режим работы с объектами. space или ins вставляют новый объект туда, куда указывает курсор.

[image: ../_images/things.png]



Мульти-выбор

При необходимости, перейдя в 2D вид, можно выделять вершины, линии, сектора и объекты при помощи:


	Клика по ним (при повторном клике по объекту выделение снимается)


	Выделения объектов рамкой, котрая появляется при зажатии ЛКМ


	Удерживая shift и ЛКМ - выделение рамкой нескольких объектов




Переключение между режимами работы с вершинами, линиями и секторами сохраняют выделение, если это возможно.




Отмена выделения

Жмём ` (обратный апостоф) в 2D виде, и выделение со всех объектов снимается.




Трансформация

У секторов, линий и вершин имеется возможность менять форму и размер.


Изменение размера

Менять размер объекта можно через меню Edit -> Scale Objects, или через клавишу F3, которая вызовет диалоговое окно.

[image: ../_images/scale-selection.png]
Выбраны 4 основных вершины

[image: ../_images/scale-dialog.png]
Смещение вершин на 50% по оси X

[image: ../_images/scale-result.png]



Вращение

ПО пункту меню Edit -> Rotate Object или  нажатию F4 появится диалоговое окно вращения.

[image: ../_images/scale-selection.png]
Выбраны 4 основных вершины

[image: ../_images/rotate-dialog.png]
Вершины повёрнуты на 45 градусов

[image: ../_images/rotate-result.png]





Текстуры


Стороны

Стороны содержат в себе данные о расположении текстур линии, которые могут быть нижними, средними и верхними.

Связь разных уровней стороны прекрасно илюстрируется отвратительным выбором текстур:

[image: ../_images/textures-sidedefs-3d.png]
Нижний уровень - COMPBLUE, средний - MIDGRATE, верхний - BRICK10

Смена текстур на стенах


	Переходим в 2D вид


	Включаем режим работы с линиями (l)


	Выделяем одну или несколько линий




[image: ../_images/textures-selection.png]

	Кликаем по кнопке текстуры «Front sidedef».Откроется браузер текстур.


	(опционально) Жмём tab и преезходим в 3D вид для просмотра изменений «вживую»


	Выбираем текстуру в окне браузера




[image: ../_images/textures-browser.png]



Текстуры пола и потолка

Переходим в режим работы с секторами и выбираем нужный сектор:

[image: ../_images/floor-ceil-texture-2d.png]
Кликаем по кнопке текстуры. Откроется браузер:

[image: ../_images/floor-ceil-buttons-closeup.png]
Жмём tab и пререходим в 3D вид для просмотра изменений «вживую»:

[image: ../_images/floor-ceil-browser.png]
Выбираем текстуру в окне браузера









          

      

      

    

  

    
      
          
            
  
Основы Маппинга


Примечание

ЛКМ: клик Левой Кнопкой Мыши, ПКМ: Клик Правой Кнопкой Мыши



Следуя данным основам, создаём новый проект в Eureka.


Добавляем комнату

Для того, чтобы было удобно рисовать комнаты, жмём f, чтобы привязать сектора к координатной сетке, и g, чтобы она появилась. Также жмём клавишу 5 для задания размера ячейки сетки в 32 еденицы.


	Жмём tab и переходим в 2D вид


	Жмём v и переходим в режим работы с вершинами


	Жмём ПКМ и начинаем рисовать сектор. Продолжаем добавлять вершины ПКМ, пока не получим нужный результат, и в конце замыкаем контур.




[image: ../_images/adding-01.png]
Добавляем текстуры на стены

Жмём l и переходим в режим работы с линиями. Свежесозданные линии будут уже выделены. Если же нет, то кликаем ЛКМ по каждой линии.

[image: ../_images/adding-02.png]

	Наводим курсор мыши на новый сектор и жмём ' (апосотф), чтобы перенести туда камеру.


	Жмём tab и переходим в 3D вид


	Кликаем на стену перед нами и выбираем текстуру SLADWALL.




[image: ../_images/adding-04.png]
[image: ../_images/adding-03.png]
Добавляем  текстуры на пол и потолок


	Жмём tab и возвращаемся в 2D вид


	Жмём s и переходим в режим работы с секторами. Сектор, по идее, уже будет выделен. Если нет - кликаем по нему ЛКМ.


	Жмём tab и переходим в 3D вид


	Кликаем по кнопкам текстур Floor и Ceiling , и выбираем текстуру FLOOR5_1.




[image: ../_images/adding-05.png]
[image: ../_images/adding-06.png]



Соединение комнат


	Жмём tab и возвращаемся в 2D вид


	Жмём v для перехода в режим работы с вершинами


	Кликаем ПКМ на линии сектора, чтобы поставить там вершину, и тянем линию до соседнего сектора. Повторить 2 раза


	Проверяем расстояние между линиями, оно должно составлять 128 едениц - такова ширина текстуры широкой двери


	По окончании имеем 2 соединенные комнаты.




[image: ../_images/joining-01.png]
[image: ../_images/joining-02.png]



Управляем высотой потолка


	Жмём tab и возвращаемся в 2D вид


	Жмём s и возвращаемся в режим работы с секторами


	Выбираем нужный сектор




[image: ../_images/joining-03.png]

	Жмём tab и переходим в 3D вид


	Кликаем по кнопкам + и - вплоть до получения нужного результата




[image: ../_images/joining-04.png]

	Как альтернативу, можно использовать клавиши []




[image: ../_images/joining-05.png]



Выравниваем текстуры


	Жмём tab для перехода в 3D режим


	Кликаем ЛКМ по стенам с кривыми текстурами




[image: ../_images/alignment-01.png]

	
	Для выравнивания текстур жмём следующие сочетания клавиш:

	
	x: выравнивание по оси X влево


	y: выравнивание по оси Y влево


	z: выравнивание по осям X и Y влево


	shift-x: выравнивание по оси X вправо


	shift-y: выравнивание по оси Y вправо


	shift-z: выравнивание по осям X и Y вправо










	Как альтернативу можно воспользоваться меню по клавише F1.




[image: ../_images/alignment-02.png]



Автоматическое выравнивание

Если же нужно выровнить несколько стен, можно воспользоваться автовыравниванием:


	В 2D виде жмём l и переходим в режим работы с линиями


	Выделяем нужние линии


	Жмём shift-A и выравниваем все выделенные линии


	Приём работает и 2D, и в 3D режиме










          

      

      

    

  

    
      
          
            
  
Примеры



	Лестница

	Изогнутая лестница

	Небо

	Жертвенный алтарь

	Лужа с отходами

	Двери

	Телепорты

	Лифты

	Ловушки

	Заготовки









          

      

      

    

  

    
      
          
            
  
Лестница

[image: ../../_images/stairs-01.png]

Схема

[image: ../../_images/stairs-02.png]



Метод


	В режиме вершин ПКМ рисуем контур будущей лестницы:




[image: ../../_images/stairs-03.png]

	Режем прямоугольник на ступеньки:




[image: ../../_images/stairs-04.png]

	В режиме секторов выбираем все ступеньки:




[image: ../../_images/stairs-05.png]

	Жмём пару раз клавишу поднятия пола . (точка)


	ЛКМ снимаем выделение с первой ступени:




[image: ../../_images/stairs-06.png]

	Повторяем предыдущие 2 шага, пока ступеи не закончатся:




[image: ../../_images/stairs-07.png]



Загрузки

stairs.wad







          

      

      

    

  

    
      
          
            
  
Изогнутая лестница

[image: ../../_images/capture_001.jpg]

Схема

[image: ../../_images/capture_002.png]



Метод

Рисуем контур будущей лестницы в режиме вершин:

[image: ../../_images/capture_003.png]
ЛКМ делим вершинами длинные стороны на отрезки, чтобы определить, где будут ступени:

[image: ../../_images/capture_0041.png]
Жмём f для отвязки вершин от сетки координат, и начинаем двигать вершины так, чтобы получилось что-то наподобие арки.

[image: ../../_images/capture_0051.png]
Снимаем выделение со всех вершин (`) и выделяем только верхний ряд:

[image: ../../_images/capture_0061.png]
Жмём shift-c (сформировать арку в 120 градусов):

[image: ../../_images/capture_0071.png]
Повторяем предыдущий шаг с нижним рядом вершин и соединяем ПКМ оба ряда линиями:

[image: ../../_images/capture_0091.png]
Переходим в режим секторов и, удерживая shift, выделяем ЛКМ сектора ступеней:

[image: ../../_images/capture_0101.png]
Поднимаем ступени клавишей . (точка). ЛКМ снимаем выделение с крайних секторов:

[image: ../../_images/capture_0111.png]

	Повторяем предыдущий пункт до тех пор, пока не дойдём до центра лестницы:




[image: ../../_images/capture_0121.png]



На заметку

Операции по формированию арки есть и в меню на клавише f1. Тем не менее, в нём нет пункта для арки в 120 градусов, так что придётся использовать сочетание клавиш shift-c.

[image: ../../_images/capture_0081.png]



Загрузки

curved-stairs.wad







          

      

      

    

  

    
      
          
            
  
Небо

[image: ../../_images/capture_0011.jpg]

Метод

Создать небо просто - нужно наложить на потолок текстуру F_SKY1.

[image: ../../_images/capture_0011.png]
Да и стены могут помочь создать неплохой вид:

[image: ../../_images/capture_0022.png]
Для стен пониже, добавляем приграничный сектор с нужной высотой (на карте он подсвечен):

[image: ../../_images/capture_0032.png]
Опускаем потолок приграничного сектора ([) и наслаждаемся видом широкого неба.




Загрузки

sky.wad







          

      

      

    

  

    
      
          
            
  
Жертвенный алтарь

[image: ../../_images/capture_004.png]
Используя концентрические круги мы построим жертвенный алтарь.


Метод

В режиме вершин рисуем нарезанный на равные отрезки прямоугольник:

[image: ../../_images/capture_005.png]
Этот прямоугольник мы превратим в круг, используя инструменты формирования арки.

Выдели центральную пару точек и подвинь их на 1.9 по оси y:

[image: ../../_images/capture_006.png]
Снимаем выделение и выбираем пары точек с обеих сторон и двигаем их на 1.8 по оси y:

[image: ../../_images/capture_007.png]
Следующие пары точек двигаем на 1.7.

[image: ../../_images/capture_008.png]
И так до тех пор, пока не дойдём до края.

Каждую пару вершин мы двигали на одну десятую меньше предыдущей, это даёт нам общий контур и задаёт направление вершин. Если мы будем формировать арку «от потолка», редактор нам выдаст сообщение «strange shape».

Выделяем врешины из верхнего ряда и формируем арку с углом 180 градусов комбинацией клавиш shift-d:

[image: ../../_images/capture_009.png]
Выделяем нижний ряд вершин и снова жмём shift-d:

[image: ../../_images/capture_010.png]
Теперь у нас есть основа будущего алтаря:

[image: ../../_images/capture_011.png]
Переходим в режим секторов и выделяем наш круг. Сочетаниями control-c и control-v делаем копию. Уменьшаем копию на 1.2 по осям x и y planes.

Переходим в 3D вид и видим, что вставленный сектор рисуется с артефактами, это потому что скопированный сектор нужно соединить с комнатой. Наводим курсор на наш сектор (его контур подсветится), и жмём пробел:

[image: ../../_images/capture_012.png]
Повторяем процедуру со вставкой кругов, уменьшая их на 1.4 и 1.6 по осям xy соответсвенно. Четырёх кругов, по идее, может быть достаточно:

[image: ../../_images/capture_014.png]
Высоту каждого этапа, текстуры пола, потолка и стен алтаря выбираем по вкусу.




Загрузки

altar.wad







          

      

      

    

  

    
      
          
            
  
Лужа с отходами

[image: ../../_images/toxic-01.png]
Токсичные отходы наносят урон игроку.


Метод


	Жмём v и переходим в режим вершин


	ПКМ рисуем русло




[image: ../../_images/toxic-02.png]

	Жмём s и переходим в режим секторов


	Жмём ` и снимаем выделение


	Выделяем сектор нашей лужи с кислотой


	Кликаем по кнопке тексуры пола и задаём текстуру NUKAGE1




[image: ../../_images/toxic-03.png]

	Указываем тип сектора, кликнув по кнопке Choose




[image: ../../_images/toxic-05.png]

	Выбираем из списка тип Damage 5%




[image: ../../_images/toxic-06.png]

	Жмём `  и снимаем выделение


	Выделяем сектора, которые будут берегами


	ПОоднимаем пол берегов, кликая по кнопке +


	Как вариант, можно поднять пол, нажимая клавишу .




[image: ../../_images/toxic-04.png]



На заметку

Как вариант, можно просто опустить русло клавишей , (запятая)




Загрузки

toxicpool.wad







          

      

      

    

  

    
      
          
            
  
Двери

[image: ../../_images/doors-01.png]
Двери, открываемые вручную, удалённо и кнопкой.


Строим дверь

Данный метод применим для создания основы дверей. На её основе можно создать дверь с кнопкой и др. двери.


	Переходим в режим вершин (v)


	Соединяем два сектора проёмом




[image: ../../_images/doors-02.png]

	Меняем размер ячеек сетки координат клавишами 3-5


	Рисуем ПКМ 2 линии, параллельные проёму




[image: ../../_images/doors-03.png]

	Переходим в режим линий (l) и выделяем переднюю и заднюю стороны двери




[image: ../../_images/doors-05.png]

	Т.к. двери выходят из потолка, выбираем передней верхней стороне текстуру ICKDOOR1.




[image: ../../_images/doors-06.png]

	Переходим в режим секторов(s) и выделяем сектор нашей двери




[image: ../../_images/doors-04.png]

	И опускаем потолок сектора до пола, используя кнопки +- возле иконки  Ceiling или клавиши [].




[image: ../../_images/doors-07.png]



На заметку

В случае, если одна из сторон двери оказалась лицевой стороной вовнутрь двери, в режиме линий жмём F1 и выбираем в меню пункт „Flip“




Обычные двери

Обычные двери - двери, которые открываются тогда, когда с ней  напрямую взаимодействует игрок.


	Переходим в режим линий (l)


	Выделяем обе стороны линий




[image: ../../_images/doors-08.png]

	В графе Type выбираем тип линии 1 DR Open Door




Чтобы дверные треки (часть дверной коробки, по которой движется дверь) не двигались вслед за дверью, нужно:


	Выделить линии треков


	Поставить галочки в окошки upper unpeg и lower unpeg




[image: ../../_images/doors-09.png]



Запертые двери

Дверь данного типа открывается ключом соответствующего цвета - Синим, Жёлтым или Красным, и создаётся также, как и обычная. При выборе типа линии обращаем внимание на цвет:

[image: ../../_images/locked-01.png]



Двери с кнопкой

Такие двери открывается при помощи кнопок, переключателей и пр.


	Переходим в режим вершин (v)


	ЛКМ ставим пару вершин рядом с дверью вдоль стены, должна получиться линия длиной в 64 еденицы




[image: ../../_images/remote-01.png]

	Переходим в режим линий (l) и выделяем получившуюся линию


	Выбираем для неё текстуру SW1GRAY




[image: ../../_images/remote-02.png]

	Задаём тип линии 63 SR Door Open


	Переводим курсор мыши на сетку, чтобы перенести фокус с панели настроек линий


	Жмём сначала ;, а затем f чтобы задать линии новый тэг




[image: ../../_images/remote-05.png]

	Переходим в режим секторов (s) и выделяем сектор двери




[image: ../../_images/remote-03.png]

	Жмём сначала ;, а затем l, чтобы присвоить сектору двери последний использованный тэг




[image: ../../_images/remote-06.png]

	Eureka подсветит линию и сектор, связанные одним тэгом:




[image: ../../_images/remote-04.png]



Загрузки

doors.wad







          

      

      

    

  

    
      
          
            
  
Телепорты

[image: ../../_images/teleport-01.png]
Телепорт срабатывает при пересечении игроком линии с соответсвующим спэшлом. Тэг линии привязывается к тому сектору, на который телепортируется игрок.


Платформа телепорта


	Рисуем сектор со стороной 64х64 еденицы


	Текстурой пола указываем GATE1, текстурой потолка - TLITE6_5




[image: ../../_images/teleport-02.png]

	Переходим в режим линий (l)


	ЖМём сначала ;, а затем f, чтобы присвоить новый тэг всем четырём линиям. Отсюда игрок будет телепортироваться.




[image: ../../_images/teleport-03.png]

	Задаём в поле Type тип линии 97 WR Teleport





Примечание

Телепорт срабатывает только тогда, когда линия направлена Лицевой стороной к игроку, а Задней - внутрь сектора. Это было сделано специально, чтобы игрок, переходя линию, не активировал ненароком другой телепорт.






Место прибытия


	Назначаем тэг линий телепорта тому сектору, в который будем телепортироваться, нажимая сначала клавишу ;, а затем l.


	Переходим в режим предметов (t), располагаем курсор мыши на секторе и жмём ins или пробел. Указываем тип предмета Type 14 Teleport Exit (в браузере предметов отмечен как TFOG)




[image: ../../_images/teleport-04.png]

	Указываем стрелками угол предмета TFOG. Углом мы указываем, в какую сторону будет смотреть игрок после телепортации.







Загрузки

teleporters.wad







          

      

      

    

  

    
      
          
            
  
Лифты

[image: ../../_images/lifts-01.png]

Метод


	Переходим в режим вершин и рисуем платформу лифта. Она должна быть вровень с поднятым сектором:




[image: ../../_images/lifts-05.png]

	Убеждаемся, что линии платформы повёрнуты лицевыми сторонами наружу, иначе лифт работать не будет.


	Если линии стоят не так, как надо, переходим в режим линий, жмём F1 и выбираем в меню пункт Flip:




[image: ../../_images/lifts-06.png]

	Выделяем линию лифта, с которй будет взаимодействовать игрок:




[image: ../../_images/lifts-02.png]

	Назначаем тип линии 62 SR Lower Lift


	Жмём сначала ; а затем f и назначаем линии новый тэг




[image: ../../_images/lifts-03.png]

	Переходим в режим секторов (s) и выделяем сектор лифта


	Жмём сначала ; а затем l и назначаем сектору последний использованный тэг




[image: ../../_images/lifts-04.png]



Загрузки

lifts.wad







          

      

      

    

  

    
      
          
            
  
Ловушки


Примеры

Все примеры доступны для тестирования в файле traps.wad




Нежданчик 1-й (скрытая комната с монстрами)

Монстры находятся в скрытой комнате, отделённой дверью или панелью, которая открывается внезапно для игрока.

[image: ../../_images/monster_closet.png]

	Рисуем скрытый сектор (А), добавляем туда монстров.


	Создаём дверь скрытого сектора (B).


	Закрываем дверь и придаём ей вид обычной стены (C).


	Задаём новый тэг сектору двери (B).


	Рисуем линию-триггер, которая будет открывать дверь комнаты с монстрами, и задаём ей тэг двери (D).


	Задаём линии-триггеру тип 109 W1 Open and stay fast  (D).







Нежданчик 2-й (платформа с монстрами)

Монстры спускаются на платформах, скрытых потолком. Особенно неприятно, когда ты идёшь за ключом в дальнем углу.

[image: ../../_images/monster_platform.png]

	Рисуем платформы и добавляем на них монстров (A).


	Поднимаем полы и потолки платформ (B), пока их пол не сравняется с потолком основной комнаты.


	Выбираем сектора платформ (A) и назначаем им новые тэги.


	Вставляем пару вершин в стену, чтобы получился отрезок в 64 еденицы для кнопки (C).


	Добавляем на отрезок текстуру кнопки или переключателя(C).


	Задаём тэг платформ линии с кнопкой (C).


	Задаём линии с кнопкой (C) тип 23 S1 Floor down LEF.







Пресс («давилка»)

Потолок опускается, раздавливая игрока.

[image: ../../_images/crusher.png]

	Задаём сектору-прессу новый тэг (A).


	Рисуем линию-триггер и назначаем ей тэг сектора-пресса (B)..


	Задаём линии-триггеру (B) тип 6 W1 Crusher /fast





Внимание

Быстрый пресс забирает здоровье понемногу, давая шанс на побег после удара. Медленный пресс даёт шанс на побег в начале, но если прозевал - умрёшь жуткой смертью.






Провал в подпол

Пол внезапно проваливается, и игрок попадает в комнату с монстрами.

[image: ../../_images/drop_trap.png]

	Рисуем сектор, который будет проваливаться под игроком (A).


	Задаём ему тэг (A).


	Добавляем скрытую комнату, куда игрок будет проваливаться, и опускаем её (B).


	Вставляем 2 вершины и создаём переключатель (C).


	Задаём переключателю тэг (C) проваливающегося сектора (A).


	Задаём линии переключателя тип 123 SR Lift Lower /fast (C).







Ловушка-мышеловка

Запирая все пути к отступлению, уровень заставляет игрока расправляться с монтрами по-быстрому.

[image: ../../_images/lock-in_trap.png]

	Создаём дверь (A) и задаём ей новый тэг.


	Рисуем линию, которая запустит процесс закрытия двери (B), и задаём ей тэг двери.


	Задаём линии-триггеру тип 16 W1 Close for 30s







Нежданчик 3-й, из телепорта

Монстры в секретной комнате, услышав шум стрельбы, начинают беситься и телепортируются на уровень.

[image: ../../_images/teleport_ambush.png]

	Назначаем новый тэг сектору, из которого монстры будут телепортироваться в сектор (A).


	Ставим предмет Teleport exit (тип 14, под категорией «Player», сокращенно TFOG) в сектор (A).


	Рисуем скрытую комнату, где будут стоять монстры (D).


	Соединяем основную комнату (A) со скрытой (D) отдушиной (B). Это поможет звуку проникнуть в скрытую комнату и поднять шум среди монстров.


	Рисуем триггер-линию телепорта в скрытой комнате (C), назначаем ей тот же тэг, что и у основной комнаты (A), и задаём тип 97 WR Teleport.







Боевая телепортация

Монстры телепортируются из одного угла карты в другой, заставляя игрока конкретно понервничать. Эта ловушка хорошо показана в Doom II, map 10, где нужно уворачиваться от Кибердемона.

[image: ../../_images/combat_teleporting.png]

	Создаём линии-триггеры с типом Type 126 WR Teleport /mon (A).


	Задаём новый тэг линии-триггеру (A).


	Присваиваем тот же тэг сектору (B)


	Ставим предмет Teleport exit в секторе (B).


	При необходимости повторяем данные шаги для создания большего количества телепортов и усложнения атак.







Токсичный сюрприз

Токсичные отходы заливают пол, нанося игроку урон во время движения.

[image: ../../_images/nukage_surprise.png]

	Рисуем линию-триггер и задаём тип 37 W1 Floor down LEF /NXP (A).


	Также задаём линии-триггеру новый тэг (A).


	Задаём тот же тэг нашему сектору-ловушке (B).


	Сектор-ловушка(B) должен быть окружен сектором с кислотой (C).


	Сектор с кислотой (C) должен быть ниже опускающегося сектора (B).


	Задаём сектору с кислотой (C) тип 7 Damage 5% и текстуру NUKAGE1. При срабатывании сектор (B) опустится до уровня сектора с уроном (C) и переймёт все его параметры (урон и текстуру).










          

      

      

    

  

    
      
          
            
  
Заготовки

Заготовки позволяют сэкономить время при создании карты благодаря простому копированию уже готовых конструкций (дверей и пр).

[image: ../../_images/capture_001.png]
При использовании заготовок нужно помнить о 2 вещах:


	Копирование работает только в пределах одного WAD файла.


	После вставки заготовки нужно объединить общие вершины.




Карту с заготовками можно расположить в неиспользуемом слоте.


Загрузки

Как основу для своего набора заготовок будем использовать файл prefabs.wad.

[image: ../../_images/capture_0021.png]



Объединение вершин

Копируя заготовку в свободное пространство, к примеру дверь, необходимо объеденить её вершины с основным сектором.

Выбрав заготовку двери в режиме секторов, жмём control-c:

[image: ../../_images/capture_0031.png]
Открыв нужную нам карту, располагаем курсор мыши в нужном месте и вставляем заготовку control-v:

[image: ../../_images/capture_0042.png]
Перейдя в режим вершин, жмём ПКМ, чтобы соеденить вершины двери с комнатой:

[image: ../../_images/capture_0052.png]
Если между дверью и комнатой дополнительный сектор не нужен, выделяем одну из вершин двери, затем одну из вершин комнаты (порядок имеет значение) и объединяем:

[image: ../../_images/capture_0062.png]
То же самое делаем и с другими вершинамя (выделяя сначала вершину двери):

[image: ../../_images/capture_0072.png]
Всё, эта сторона двери готова:

[image: ../../_images/capture_0082.png]



Объединение секторов

Процесс вставки одного сектора в другой требует иного способа объединения. Лестница - лишь один из примеров.

Выбираем сектора заготовки. Используем комбинацию shift LMB, чтобы рамкой выделить все нужные сектора:

[image: ../../_images/capture_0092.png]
Копируем, открываем нашу карту, и вставляем. Убеждаемся в том, что курсор мыши находится в нужном месте:

[image: ../../_images/capture_0102.png]
Переходим в 3D вид, видим наши артефакты, говорящие о необходимости объединения:

[image: ../../_images/capture_0112.png]
Чтобы объединить сектора, снимаем выделение (`), наводим курсор на сектор комнаты и жмём space:

[image: ../../_images/capture_0122.png]
Всё, теперь сектора лестницы объединены с сектором комнаты:

[image: ../../_images/capture_013.png]






          

      

      

    

  

    
      
          
            
  
Шпаргалка

Данная шпаргалка - список горячих сочетаний клавиш и кнопок мыши, которые используются в Eureka.
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